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CHAPTER 1

Setting Up Access to Cisco Personal
Communications Assistant

* Setting Up Access to Cisco Personal Communications Assistant, on page 1

Setting Up Access to Cisco Personal Communications Assistant

Introduction

The Cisco Personal Communications Assistant (PCA) is installed on the Cisco Unity Connection server during
installation. It is a website that provides users with access to the Cisco Unity web tools, which allow users to
manage messages and personal preferences in Unity Connection. The web tools available in the Cisco PCA
include:

* Messaging Assistant
* Cisco Unity Connection Personal Call Transfer Rules

To learn more about the tools listed above, see the applicable User Guide for Cisco Unity Connection and the
Help for each tool.

Configuring a Web Browser to Access Cisco PCA

The browsers on each user workstation must be set up to use the Cisco PCA and the Cisco Unity Connection
web tools. See the applicable section, depending on the browser installed on the computer:

For the list of versions supported for each browser, see the Compatibility Matrix for Cisco Unity Connection
, available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/compatibility/matrix/b_cucclientmtx.html.

Apple Safari
Do the following tasks to set up Safari for accessing the Cisco PCA.

1. Confirm that the software required for correct browser configuration is installed. See the "Software
Requirements—User Workstations" section of the System Requirements for Cisco Unity Connection
Release 15, available at https://www.cisco.com/c/en/us/td/docs/voice ip comm/connection/15/requirements/
b_15cucsysreqs.htm.
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. Changing the GUI Language for the Cisco PCA

2.

Configure Safari:

a. Enable Java.
b. Enable Java Script.
C. Accept cookies only from sites that you navigate to.

Microsoft Internet Explorer

Do the following tasks to set up Internet Explorer for accessing the Cisco PCA.

1.

Confirm that the software required for correct browser configuration is installed. See the "Software
Requirements—User Workstations" section of the System Requirements for Cisco Unity Connection
Release 15, available at https://www.cisco.com/c/en/us/td/docs/voice ip comm/connection/15/requirements/
b_15cucsysregs.htm.

Configure Internet Explorer:

Enable Active scripting.

Download and run ActiveX controls.

Enable Java scripting.

Accept all cookies.

Automatically check for newer versions of temporary Internet files.
Enable Medium-High privacy.

~® 00 o

Mozilla Firefox

Do the following tasks to set up Firefox for accessing the Cisco PCA.

1. Confirm that the software required for correct browser configuration is installed. See the "Software

Requirements—User Workstations" section of the System Requirements for Cisco Unity Connection
Release 15, available at https://www.cisco.com/c/en/us/td/docs/voice ip_comm/connection/15/requirements/
b_15cucsysreqs.htm.

If users are running Firefox on Apple MAC OS X or Microsoft Windows workstations, skip to Task 3.

If users are running Firefox on Linux Red Hat workstations, confirm that they are using the correct sound
card by referring to the sound card support matrix on the Alsa-project.org website. (Note that the Java
Runtime Environment (JRE) plug-in software uses the Advanced Linux Sound Architecture (ALSA)
driver to access system sound devices and to control playback and recording functionality. Depending on
the sound card, playback and recording capabilities may be limited.)

3. Configure Firefox:

a. Enable Java.

b. Enable Java Script > Enable Change Images in Java Script Advanced.

c. Allow sites to set cookies. (For security purposes, we recommend that you set this to Allow Sites to
Set Cookies for the Originating Web Site Only.)

Changing the GUI Language for the Cisco PCA

Do the following tasks to change the GUI language that is used in the Cisco PCA.

1. Download and install the applicable languages. For instructions, see the applicable documentation:
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» < For anew Unity Connection server, see the "Installing Unity Connection Language" section of
the "Maintaining Cisco Unity Connection Server" chapter of the Install, Upgrade, and
Maintenance Guide for Cisco Unity Connection, Release 15, at
https://www.cisco.com/c/en/us/td/docs/voice ip commvconnection/15/install upgrade/guide/b 15cuciumghtml.

» < For an existing Unity Connection server, see the "Removing Unity Connection Language"
section of the "Maintaining Cisco Unity Connection Server" chapter of the Install, Upgrade,
and Maintenance Guide for Cisco Unity Connection, Release 15, at at
https:/mwww.cisco.comv/c/en/us/td/docs/voice ip_comm/connection/15/install upgrade/guide/b 15cuciumg html.

2. On the user workstation, select a language in the web browser. The language selected in the browser must
be one of the languages that the Cisco PCA offers and it must be installed on the Unity Connection server.
For a list of supported languages, see the "Available Languages for Unity Connection Components"
section of the System Requirements for Cisco Unity Connection Release 15 at https://www.cisco.com/c/
en/us/td/docs/voice ip comm/connection/15/requirements/b _15cucsysreqgs.htm.

Managing Security Alerts Using Self-Signed Certificates with SSLConnections

If you use the self-signed certificate generated during installation to provide an SSL, Unity Connection to the
Cisco PCA, the web browser of the user displays a message to alert the user that the authenticity of the site
cannot be verified, and therefore its content cannot be trusted. Similarly, if you use a self-signed SSL certificate
to secure IMAP email client access to Unity Connection, some email clients supported for use with Unity
Connection display SSL security messages.

Although users can still access Unity Connection despite the alerts, consider one of the following options to
manage or eliminate security alerts when users browse to the Cisco PCA and/or access their messages from
an IMAP email client:

» Add the SSL certificate to the Trusted Root Store on each user workstation. In this way, you can ensure
that users never see the security alert. Do the following Adding the SSL Certificate to the Trusted Root
Store on User Workstations, on page 3 procedure.

» Tell users to choose the "Accept Permanently" (or similar) option when the browser or email client
displays the alert and asks them how to proceed. After instructing the browser and/or email client to
always accept the certificate, the user will not see the alert again.

Adding the SSL Certificate to the Trusted Root Store on User Workstations

Procedure

Command or Action Purpose

Step 1 From the OS Administration application on the Unity
Connection server, right-click to download the certificate
and save it as a file.

Step 2 Copy the certificate to each user workstation, and then
import it using tools in the browser or IMAP client, as
applicable.
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Setting Up Playback and Recording Devices

» Setting Up Playback and Recording Devices, on page 5

Setting Up Playback and Recording Devices

Setting Up Playback and Recording Devices for the Media Player

In Unity Connection, Media Player provides the functionality of play, record, upload and download a voice
name of a user and greetings using phone .

Media Player supports computer along with phone for recording and playback device. You can select any of
the device using Toggle button on the Media Player. By default, computer option is enabled as playback and
recording device.

To set the phone as a recording and playback device, see the section Using Phone as a Recording and Playback
Device

To set the computer as a recording and playback device, see the section Using Computer Microphone and
Speakers as the Recording and Playback Devices

For more information on the Media Player, see "Media Player in the Messaging Assistant Web Tool" chapter
of the User Guide for the Cisco Unity Connection Messaging Assistant Web Tool available at
https://www.cisco.com/c/en/us/td/docs/voice_ip comm/connection/15/user/guide/assistant/b_15cucugasst.html.

Using Phone as a Recording and Playback Device

When users use the phone as a recording and playback device in the web tools that are accessed through the
Cisco PCA (and in Cisco Unity Connection Administration), the following events occur:

1. The user selects the applicable option in the client application to make or play a recording.

2. The client application asks Unity Connection to place a call to the user extension or URI, and Unity
Connection calls the extension or URI.

3. When making a recording, the user answers the phone, and begins recording the message, name, or
greeting. When the user hangs up, the client application tells Unity Connection that the recording is
finished.
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4. When playing a recording, the user answers the phone, and the client application asks Unity Connection
to play the message. Unity Connection streams the recording by phone.

Using Computer Microphone and Speakers as the Recording and Playback
Devices

When users use a computer microphone and speakers as the recording and playback devices, the following
events occur:

1. The user selects the applicable option in the client application to make or play a recording.

2. When making a recording, the user begins speaking into the microphone. When the user selects the
applicable option in the client application to stop recording, the client application tells Cisco Unity
Connection that the recording is finished.

3. When playing a recording, Unity Connection streams the message to the client application. Streaming
occurs on demand, regardless of network traffic. The client application begins to play the message through
the speakers as soon as a few seconds of the message are buffered in memory on the user workstation.
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Connection Voice Messages

* Configuring an Email Account to Access Unity Connection Voice Messages, on page 7

Configuring an Email Account to Access Unity Connection Voice
Messages

Overview

Cisco Unity Connection allows licensed users to use a third-party IMAP client to access voice messages from
their desktop machines. You can also forward voice messages with text and reply to voice messages with text;
the text portion of the message is accessible through the Unity Connection text-to-speech feature.

\ )

Note When users change their Cisco Personal Communications Assistant (PCA) password (also known as the
web-application password) in the Unity Connection Messaging Assistant, they also must update the password
in their IMAP client application. Passwords are not synchronized between IMAP clients and the Cisco PCA.
If users have trouble receiving voice messages in an IMAP client even after updating their Cisco PCA password
in both applications, see the Creating Registry Entries for Microsoft Outlook.

Considerations to Configure IMAP Email Clients

Note the following considerations when configuring IMAP email clients to access Unity Connection voice
messages:

* In Cisco Unity Connection Administration, configure the following settings on the System Settings >
SMTP Configuration > Server page to match the SSL settings in the IMAP email clients:

* Allow Connections From Untrusted IP Addresses
* Require Authentication From Untrusted IP Addresses

* Transport Layer Security From Untrusted IP Addresses Is (Disabled, Required, Optional)
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* IMAP email clients all include two fields in which you can enter either the IP address or the fully qualified
domain name of the Unity Connection server. When a Unity Connection cluster is configured, enter the
fully qualified domain name of a DNS A record that includes the Unity Connection publisher and
subscriber servers. If your DNS server allows you to specify the order in which DNS tries to contact
Unity Connection servers, specify that the server that is available most often is the first server contacted.
This usually is the publisher server.

Some IMAP email clients do not respect DNS A records. For those clients, if the first Unity Connection server
is not available, the client does not try to access the other Unity Connection server.

* When a user forwards or replies to a voice message from an IMAP email client, the message will be sent
to recipients on the Unity Connection server unless the user specifically configures the message to be
sent through another account.

Creating and Configuring an Account to Access Unity Connection in Apple

To use Apple Mail to access Unity Connection voice messages, create and configure a new Apple Mail account
for the user. You need the following information:

+ Unity Connection username (alias).

* Cisco Personal Communications Assistant (PCA) password. (This is the web application password that
is set on the User pages in Cisco Unity Connection Administration.)

* The IP address, or if DNS is configured, the fully qualified domain name of the Unity Connection server.

Creating and Configure a New Account in Apple Mail

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6

Step 7
Step 8

Step 9
Step 10

In Apple Mail, on the Mail menu, select Preferences.

At the top of the Preferences dialog box, select Accounts.

In the lower left corner, select +.

In the Account Type list, select IMAP.

In the Description field, enter a name for the account. This name appears only in Apple Mail.

In the E-Mail Address field, enter the Unity Connection SMTP Address of the user and the name of the Unity Connection
server. You can find this information in the SMTP Address field on the User Basics page in Cisco Unity Connection
Administration. The E-Mail Address typically follows this format:

<alias>@<fully qualified domain name of the Unity Connection server>

In the Full Name field, enter the username.

In the Incoming Mail Server field, enter the IP address or the fully qualified domain name of the Unity Connection
server.

Caution Do not use the fully qualified domain name of the Unity Connection server unless DNS is configured for
the network.

In the User Name field, enter the Unity Connection username.

In the Password field, enter the Cisco PCA password.
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Step 11

Step 12
Step 13

Step 14
Step 15
Step 16
Step 17
Step 18
Step 19

Creating and Configuring an Account to Access Unity Connection in Eudora .

In the Outgoing Mail Server (SMTP) field, select the IP address or the fully qualified domain name of the Unity
Connection server.

Select Server Settings.
Optionally, in the SMTP Server Options dialog box, check the Use Secure Sockets Layer (SSL) check box.
Caution If you do not configure Apple Mail to use SSL, the Unity Connection username and password that are sent

to Unity Connection over the network and the voice messages sent back from Unity Connection are not
encrypted.

In the Authentication list, select Password.

Select OK to close the SMTP Options dialog box.

Select the Advanced tab.

In the Keep Copies of Messages for Offline Viewing list, select the applicable option.
Close the Preferences dialog box.

In the Save Changes dialog box, select Save.

Creating and Configuring an Account to Access Unity Connection in Eudora

To use Eudora to access Unity Connection voice messages, create and configure a new Eudora account for
the user. You need the following information:

* Unity Connection username (alias).

* Cisco Personal Communications Assistant (PCA) password. (This is the web application password that
is set on the User pages in Cisco Unity Connection Administration.)

* The IP address, or if DNS is configured, the fully qualified domain name of the Unity Connection server.

Creating and Configure a New Account in Eudora

Step 1
Step 2
Step 3
Step 4

Step 5

Step 6
Step 7
Step 8
Step 9

Start Eudora.
On the Eudora Tools menu, select Personalities.
Right-click anywhere in the Personalities tab, and select New.

In the New Account wizard, on the Account Settings page, select Next to accept the default value, Create a Brand New
E-Mail Account.

On the Personality Name page, enter a display name for the account. The value that you enter here is visible only in
Eudora.

Select Next.
On the Personal Information page, enter the username.
Select Next.

On the E-Mail Address page, enter the Unity Connection SMTP Address of the user and the name of the Unity Connection
server. You can find this information in the SMTP Address field on the User Basics page in Cisco Unity Connection
Administration. The E-Mail Address typically follows this format:

<alias>@<fully qualified domain name of the Unity Connection server>
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Step 10 Select Next.

Step 11 On the User Name page, enter the Unity Connection username.

Step 12 Select Next.

Step 13 On the Incoming E-Mail Server page, enter the IP address or the fully qualified domain name of the Unity Connection
server.
Caution Do not use the fully qualified domain name of the Unity Connection server unless DNS is configured for

the network.

Step 14 For the type of server, select IMAP.

Step 15 Select Next.
Step 16 On the IMAP Location Prefix page, do not enter a value.
Step 17 Select Next.
Step 18 On the Outgoing E-Mail Server page, enter the IP address or the fully qualified domain name of the Unity Connection
server.
Step 19 Select Next.
Step 20 On the Success page, select Finish to create the account and close the wizard.
Step 21 In the Enter Password dialog box, enter the Cisco PCA password of the user.
Step 22 Select OK.
Step 23 Optionally, configure the new account to use SSL. For more information, see Eudora Help.
Caution If you do not configure Eudora to use SSL, the Unity Connection username and password that are sent to
Unity Connection over the network and the voice messages sent back from Unity Connection are not
encrypted.

Creating and Configuring an Accountto Access Unity Connection in IBM Lotus
Notes

A

Caution  If you plan to configure user accounts to use Cisco Unity Connection ViewMail for IBM Lotus Notes, do not
follow the instructions in this section. Instead, follow the configuration instructions in the Release Notes for
Cisco Unity Connection ViewMail for IBM Lotus Notes, available at
http://www.cisco.com/en/US/products/ps6509/prod_release notes_list.html.

To use Notes to access Unity Connection voice messages, create and configure a new Notes account for the
user. You need the following information:

* Unity Connection username (alias).

* Cisco Personal Communications Assistant (PCA) password. (This is the web application password that
is set on the User pages in Cisco Unity Connection Administration.)

* The IP address, or if DNS is configured, the fully qualified domain name of the Unity Connection server.
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Creating and Configure a New Account in IBM Lotus Notes .

A

Caution  When using Lotus Notes version 7.x to access Unity Connection voice messages,
you must first configure Notes to connect to a Domino account before configuring
the Unity Connection account.

Creating and Configure a New Account in IBM Lotus Notes

Step 1
Step 2
Step 3

Step 4
Step 5
Step 6
Step 7

Step 8
Step 9

Step 10
Step 11

Step 12
Step 13
Step 14

Step 15
Step 16

Step 17
Step 18

Start IBM Lotus Notes.
On the Notes File menu, select Preferences > Client Reconfiguration Wizard.

In the Lotus Notes Client Configuration wizard, on the Additional Services page, check the Internet Mail Servers
(POP or IMAP, SMTP) check box.

Select Next.

On the Set Up Internet Mail page, in the Select the Type of Server Used for Retrieving Incoming Mail list, select IMAP.
In the Enter a New Account Name list, select Incoming Internet Mail.

In the Incoming Mail Server field, enter the IP address or the fully qualified domain name of the Unity Connection

SCrver.

Caution Do not use the fully qualified domain name of the Unity Connection server unless DNS is configured for
the network.

Select Next.

On the Set Up Internet Mail page, in the Account Name field, enter the Unity Connection SMTP Address of the user
and the name of the Unity Connection server. You can find this information in the SMTP Address field on the User
Basics page in Cisco Unity Connection Administration. The Account Name typically follows this format:

<alias>@<fully qualified domain name of the Unity Connection server>

In the Password fields, enter and confirm the Cisco PCA password of the user.
If you want to encrypt voice messages and other data that are sent between Notes and Unity Connection, check the Log
On Using SSL check box. If not, skip to Step 12.

Caution If you do not configure Notes to use SSL, the Unity Connection username and password that are sent to
Unity Connection over the network and the voice messages that are sent back from Unity Connection are
not encrypted.

Select Next.
On the second Set Up Internet Mail page, in the Enter a New Account Name list, select Outgoing Internet Mail.

In the Outgoing SMTP Mail Server list, enter the IP address or the fully qualified domain name of the Unity Connection
server.

Select Next.

On the third Set Up Internet Mail page, in the E-Mail Address field, enter the Unity Connection alias of the user and
the name of the Unity Connection server. Use the following format:

<alias>@<fully qualified domain name of the Unity Connection server>

In the Internet Domain field, enter the Internet domain name of the Domino mail server.

Select Next.
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Step 19 Select OK.

Creating and Configuring an Account to Access Unity Connection in Microsoft
Outlook

A

Caution  If you plan to configure user accounts to use Cisco ViewMail for Microsoft Outlook, do not follow the
instructions in this section. Instead, follow the configuration instructions in the applicable Release Notes for
Cisco ViewMail for Microsoft Outlook, available at
http://www.cisco.com/en/US/products/ps6509/prod_release notes_list.html.

To use Microsoft Outlook to access Unity Connection voice messages, create and configure a new Microsoft
Outlook account for the user. You need the following information:

+ Unity Connection username (alias).

* Cisco Personal Communications Assistant (PCA) password. (This is the web application password that
is set on the User pages in Cisco Unity Connection Administration.)

* The IP address, or if DNS is configured, the fully qualified domain name of the Unity Connection server.
In addition to configuring Microsoft Outlook to access Unity Connection voice messages, you can also install

the optional ViewMail for Outlook plug-in. See the Creating and Configuring an Account to Access Unity
Connection in Microsoft Outlook Express.

Creating and Configuring a New Account in Outlook

Step 1 Start Microsoft Outlook.

Step 2 On the Microsoft Outlook Tools menu, select E-Mail Accounts.
Step 3 In the E-Mail Accounts wizard, select Add a New E-Mail Account.
Step 4 Select Next.

Step 5 On the Server Type page, select IMAP.

Step 6 Select Next.

Step 7 Enter values in the User Information section:

a) Inthe Your Name field, enter a display name for the account. The value that you enter here is visible only in
Microsoft Outlook.

b) In the E-Mail Address field, enter one of the following:

* The Unity Connection SMTP Address of the user and the name of the Unity Connection server. You can find
this information in the SMTP Address field on the User Basics page in Cisco Unity Connection Administration.
The E-Mail Address typically follows this format:

<alias>@<SMTP domain name of the Unity Connection server or cluster>

* The proxy address for the user.
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Step 8

Step 9

Step 10

Step 11
Step 12
Step 13
Step 14
Step 15

Step 16
Step 17
Step 18
Step 19
Step 20
Step 21
Step 22
Step 23
Step 24
Step 25

Creating and Configuring a New Account in Outlook .

Enter values in the Server Information section:
a) Inthe Incoming Server field, enter the IP address or the fully qualified domain name of the Unity Connection server.

Caution Do not use the fully qualified domain name of the Unity Connection server unless DNS is configured
for the network.

b) In the Outgoing Server field, select the IP address or the fully qualified domain name of the Unity Connection
server.
Enter values in the Logon Information section:

a) Inthe User Name field, enter the Unity Connection username.
b) In the Password field, enter the Cisco PCA password of the user.

c) Verify that the Remember Password check box is not checked. If this option is checked, and the Unity Connection
password of the user expires, changes, or is locked, Microsoft Outlook does not prompt the user to enter the Unity
Connection password. The result is that users do not receive voice messages from Unity Connection.

If you do not want to encrypt voice messages and other data that are sent over the network between Microsoft Outlook
and Unity Connection, skip to Step 15.

If you do not configure Microsoft Outlook to use SSL, the Unity Connection username and password that are sent to
Unity Connection over the network and the voice messages sent back from Unity Connection are not encrypted.

Caution If you want to encrypt voice messages and other data that are sent between Microsoft Outlook and Unity
Connection, continue with Step 11.

Select More Settings.

In the Internet E-Mail Settings dialog box, select the Advanced tab.

Under Incoming Server (IMAP), check the This Server Requires an Encrypted Unity Connection (SSL) check box.
Select OK to close the Internet E-Mail Settings dialog box.

If the Unity Connection SMTP server is configured to allow connections from untrusted IP addresses, skip to Step 21.

If the Unity Connection SMTP server is configured to require authentication from untrusted IP addresses, continue
with Step 16.

Select More Settings.

In the Internet E-Mail Settings dialog box, select the Outgoing Server tab.

Verify that the My Outgoing Server (STMP) Requires Authentication check box is checked.
Verify that Use Same Settings as My Incoming Mail is selected.

Select OK to close the Internet E-Mail Settings dialog box.

Select Next.

Select Finish.

In the left pane of Microsoft Outlook, select the Inbox folder for the new account.

On the Microsoft Outlook Tools menu, select Send/Receive > This Folder.

If prompted, enter the Unity Connection username and Cisco PCA password.
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. Creating and Configuring an Account to Access Unity Connection in Microsoft Outlook Express

Creating and Configuring an Account to Access Unity Connection in Microsoft
Outlook Express

To use Microsoft Outlook Express to access Unity Connection voice messages, create and configure a new
Microsoft Outlook Express account for the user. You need the following information:

+ Unity Connection username (alias).

* Cisco Personal Communications Assistant (PCA) password. (This is the web application password that
is set on the User pages in Cisco Unity Connection Administration.)

* The IP address, or if DNS is configured, the fully qualified domain name of the Unity Connection server.

Creating and Configuring a New Account in Microsoft Outlook Express

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6
Step 7
Step 8

Step 9
Step 10
Step 11

Step 12

Step 13
Step 14

Step 15

Step 16
Step 17

Start Microsoft Outlook Express.

On the Microsoft Outlook Express Tools menu, select Accounts.

In the Internet Accounts dialog box, select the Mail tab.

Select Add > Mail, and the Internet Unity Connection wizard appears.

On the Your Name page, in the Display Name field, enter the username.

Select Next.

On the Internet E-Mail Address page, select | Already Have an E-Mail Address That 1'd Like to Use.

In the E-Mail Address field, enter the SMTP Address of the user and the name of the Unity Connection server. You
can find this information in the SMTP Address field on the User Basics page in Cisco Unity Connection Administration.
The E-Mail Address typically follows this format:

<alias>@<fully qualified domain name of the Unity Connection server>

Select Next.

On the E-Mail Server Names page, in the My Incoming Mail Server Is a <protocol> Server list, select IMAP.

In the Incoming Mail (POP3, IMAP, or HTTP) Server field, enter the IP address or the fully qualified domain name of
the Unity Connection server.

Caution Do not use the fully qualified domain name of the Unity Connection server unless DNS is configured for
the network.

In the Outgoing Mail (SMTP) Server field, enter the IP address or the fully qualified domain name of the Unity
Connection server.

Select Next.

On the Internet Mail Logon page, in the Account Name and Password fields, enter the Unity Connection username and
Cisco PCA password.

Verify that the Remember Password check box is not checked.
If this option is checked, and the Unity Connection password of the user expires, changes, or is locked, Microsoft

Outlook Express does not prompt the user to enter the Unity Connection password. The result is that users do not receive
voice messages from Unity Connection.

Select Next.
On the Congratulations page, select Finish.
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Step 18
Step 19
Step 20
Step 21
Step 22

Step 23
Step 24
Step 25
Step 26

Creating and Configuring an Account to Access Unity Connection in Novell GroupWise .

In the Internet Accounts dialog box, select the account that you created in Step 4, and select Properties.

In the <account name> Properties dialog box, select the IMAP tab.

Uncheck the Store Special Folders check box.

In the Root Folder Path field, enter INBOX (all upper-case letters).

If you do not want to encrypt voice messages and other data that are sent over the network between Microsoft Outlook
Express and Unity Connection, skip to Step 25.

Caution If you do not configure Microsoft Outlook Express to use SSL, the Unity Connection username and
password that are sent to Unity Connection over the network and the voice messages sent back from Unity
Connection are not encrypted.

If you want to encrypt voice messages and other data that are sent between Microsoft Outlook Express and Unity
Connection, continue with Step 23.

Select the Advanced tab.
Under Incoming Mail, check the This Server Requires a Secure Unity Connection (SSL) check box.

Select OK to close the <account name> Properties dialog box.

Select Close to close the Internet Accounts dialog box.

Creating and Configuring an Account to Access Unity Connection in Novell
GroupWise

To use GroupWise to access Unity Connection voice messages, create and configure a new GroupWise account
for the user. You need the following information:

* Unity Connection username (alias).

* Cisco Personal Communications Assistant (PCA) password. (This is the web application password that
is set on the User pages in Cisco Unity Connection Administration.)

* The IP address, or if DNS is configured, the fully qualified domain name of the Unity Connection server.

Creating and Configuring a New Account in GroupWise

Step 1
Step 2
Step 3
Step 4

Step 5
Step 6
Step 7

Start GroupWise.
On the GroupWise Tools menu, select Accounts > Account Options.
In the Accounts dialog box, select Add.

In the Create Account dialog box, in the Account Name field, enter a name for the account. This name appears only in
GroupWise.

In the Account Type list, select IMAPA4.

Select Next.

In the Create Internet Account dialog box, in the Incoming Mail Server (IMAP4) field, enter the IP address or the
fully qualified domain name of the Unity Connection server.

Caution Do not use the fully qualified domain name of the Unity Connection server unless DNS is configured for
the network.
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. Creating and Configuring an Account to Access Unity Connection in Opera

Step 8
Step 9
Step 10

Step 11
Step 12
Step 13
Step 14

Step 15
Step 16
Step 17
Step 18
Step 19
Step 20
Step 21

In the Login Name field, enter the Unity Connection username.
In the Outgoing Server field, enter the IP address or the fully qualified domain name of the Unity Connection server.

In the E-Mail Address field, enter the SMTP Address of the user and the name of the Unity Connection server. You
can find this information in the SMTP Address field on the User Basics page in Cisco Unity Connection Administration.
The E-Mail Address typically follows this format:

<alias>@<fully qualified domain name of the Unity Connection server>

In the From Name field, enter the username.

Select Next.

Follow the on-screen prompts to complete the configuration.

If you do not want to encrypt voice messages and other data that are sent over the network between GroupWise and
Unity Connection, skip to Step 20.

Caution If you do not configure GroupWise to use SSL, the Unity Connection username and password that are sent
to Unity Connection over the network and the voice messages sent back from Unity Connection are not
encrypted.

If you want to encrypt voice messages and other data that are sent between GroupWise and Unity Connection, continue
with Step 15.

In the Accounts dialog box, select the name of the account that you just created.

Select Properties.

Select the Advanced tab.

Under Incoming Mail Server (IMAP4), check the Use SSL check box.

Select OK to close the <Account Name> Properties dialog box.

Select Close to close the Accounts dialog box.

Create the inbox for the new account, and download Unity Connection voice messages:

a) In the left pane of GroupWise, select the name of the new account.
b) In the Logon to <AccountName> dialog box, enter the Cisco PCA password for the user.
c) Verify that the Remember Password check box is not checked.

If this option is checked, and the Unity Connection password of the user expires, changes, or is locked, GroupWise
does not prompt the user to enter the Unity Connection password. The result is that users do not receive voice
messages from Unity Connection.

d) Select OK to close the Logon to <AccountName> dialog box.

e) With the name of the new account still selected in the left pane, on the GroupWise Tools menu, select Send/Receive >
This Folder.

Creating and Configuring an Account to Access Unity Connection in Opera

To use Opera to access Unity Connection voice messages, create and configure a new Opera account for the
user. You need the following information:

* Unity Connection username (alias).

* Cisco Personal Communications Assistant (PCA) password. (This is the web application password that
is set on the User pages in Cisco Unity Connection Administration.)
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Creating and Configuring a New Account in Opera .

* The IP address, or if DNS is configured, the fully qualified domain name of the Unity Connection server.

Creating and Configuring a New Account in Opera

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6
Step 7

Step 8
Step 9
Step 10
Step 11
Step 12
Step 13

Step 14

Step 15
Step 16
Step 17
Step 18

Start Opera.

On the Opera Tools menu, select Mail and Chat Accounts.
In the Manage Accounts dialog box, select New.

In the New Account wizard, select IMAP.

Select Next.

In the Real Name field, enter the account name.

In the E-Mail Address field, enter the Unity Connection SMTP Address of the user and the name of the Unity Connection
server. You can find this information in the SMTP Address field on the User Basics page in Cisco Unity Connection
Administration. The E-Mail Address typically follows this format:

<alias>@<fully qualified domain name of the Unity Connection server>

In the Organization field, enter the applicable value.

Select Next.

In the Login Name field, enter the Unity Connection username.

In the Password field, enter the Cisco PCA password.

Select Next.

In the Incoming Server field, enter the IP address or the fully qualified domain name of the Unity Connection server.

Caution Do not use the fully qualified domain name of the Unity Connection server unless DNS is configured for
the network.

If you want to encrypt voice messages and other data that are sent between Opera and Unity Connection, check the
Use Secure Unity Connection (TLS) check box. (TLS is an updated version of SSL.)

Caution If you do not configure Opera to use SSL, the Unity Connection username and password that are sent to
Unity Connection over the network and the voice messages sent back from Unity Connection are not
encrypted.

In the Outgoing Server field, enter the IP address or the fully qualified domain name of the Unity Connection server.
Select Finish.

Select OK to close the Subscribe IMAP Folders dialog box.
Select OK to close the Manage Accounts dialog box.

Creating and Configuring an Account to Access Unity Connection in
Thunderbird

To use Thunderbird to access Unity Connection voice messages, create and configure a new Thunderbird
account for the user. You need the following information:

* Unity Connection username (alias).
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. Creating and Configuring a New Account in Thunderbird

* Cisco Personal Communications Assistant (PCA) password. (This is the web application password that
is set on the User pages in Cisco Unity Connection Administration.)

* The IP address, or if DNS is configured, the fully qualified domain name of the Unity Connection server.

Creating and Configuring a New Account in Thunderbird

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6

Step 7
Step 8
Step 9

Step 10
Step 11
Step 12
Step 13
Step 14
Step 15
Step 16

Step 17
Step 18
Step 19
Step 20

Step 21

Start Thunderbird.

On the Thunderbird File menu, select New > Account.

In the Account wizard, on the New Account Setup page, select E-Mail Account.
Select Next.

On the Identity page, in the Your Name field, enter the username.

In the E-Mail Address field, enter the Unity Connection SMTP Address of the user and the name of the Unity Connection
server. You can find this information in the SMTP Address field on the User Basics page in Cisco Unity Connection
Administration. The E-Mail Address typically follows this format:

<alias>@<fully qualified domain name of the Unity Connection server>

Select Next.
On the Server Information page, under Select the Type of Incoming Server You Are Using, select IMAP.
In the Incoming Server field, enter the IP address or the fully qualified domain name of the Unity Connection server.

Caution Do not use the fully qualified domain name of the Unity Connection server unless DNS is configured for
the network.

Select Next.

On the User Names page, enter the Unity Connection username.

Select Next.

On the Account Name page, enter a name for the account. This name appears only in Thunderbird.

Select Next.

On the Congratulations page, confirm that the settings are correct, then select Finish.

If you do not want to encrypt voice messages and other data that are sent over the network between Thunderbird and

Unity Connection, you are finished creating and configuring a new account.

If you want to encrypt voice messages and other data that are sent between Thunderbird and Unity Connection, continue
with Step 17.

In the left pane of Thunderbird, select the name of the account that you just created.

In the right pane of Thunderbird, under Accounts, select View Settings for This Account.

In the Account Settings dialog box, under the account that you just created, select Server Settings.

Under Server Settings, select the Use Secure Unity Connection (SSL) check box.

Caution If you do not configure Thunderbird to use SSL, the Unity Connection username and password that are

sent to Unity Connection over the network and the voice messages sent back from Unity Connection are
not encrypted.

Select OK to close the Account Settings dialog box.
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Creating and Configuring an Account to Access Unity Connection in Windows Mail for Windows Vista .

Creating and Configuring an Account to Access Unity Connection in Windows
Mail for Windows Vista

To use Windows Mail for Windows Vista to access Unity Connection voice messages, create and configure
a new Windows Mail account for the user. You need the following information:

+ Unity Connection username (alias).

* Cisco Personal Communications Assistant (PCA) password. (This is the web application password that
is set on the User pages in Cisco Unity Connection Administration.)

* The IP address, or if DNS is configured, the fully qualified domain name of the Unity Connection server.

Creating and Configuring a New Account in Windows Mail

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6
Step 7
Step 8

Step 9
Step 10
Step 11

Step 12

Step 13

Step 14
Step 15
Step 16
Step 17
Step 18

Start Windows Mail.

On the Tools menu, select Accounts.

In the Internet Accounts dialog box, select Add.

On the Select Account Type page, select E-Mail Account.

Select Next.

On the Your Name page, in the Display Name field, enter the username.
Select Next.

On the Internet E-Mail Address page, in the E-Mail Address field, enter the Unity Connection SMTP Address of the
user and the name of the Unity Connection server. You can find this information in the SMTP Address field on the
User Basics page in Cisco Unity Connection Administration. The E-Mail Address typically follows this format:

<alias>@<fully qualified domain name of the Unity Connection server>

Select Next.

On the Set Up E-Mail Servers page, under Incoming E-Mail Server Type, select IMAP.

In the Incoming Mail (POP3 or IMAP) Server field, enter the IP address or the fully qualified domain name of the
Unity Connection server.

Caution In Step 11 and Step 12, do not use the fully qualified domain name of the Unity Connection server unless
DNS is configured for the network.

In the Outgoing E-Mail Server (SMTP) Name field, enter the IP address or the fully qualified domain name of the Unity
Connection server.

If the Unity Connection SMTP server is configured to allow connections from untrusted IP addresses, skip to Step 15.

If the Unity Connection SMTP server is configured to require authentication from untrusted IP addresses, continue
with Step 14.

Check the Outgoing Server Requires Authentication check box.

Select Next.

On the Internet Mail Logon page, enter the user Unity Connection alias and Cisco PCA password.
Select Next.

On the Congratulations page, select Finish.
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. Setting Up ViewMail for Outlook

Step 19
Step 20

Step 21
Step 22
Step 23
Step 24

Step 25

Step 26

Select Close to close the Internet Accounts dialog box.
If you do not want to encrypt voice messages and other data that are sent over the network between Windows Mail and
Unity Connection, you are finished creating and configuring a new account.

If you want to encrypt voice messages and other data that are sent between Windows Mail and Unity Connection,
continue with Step 21.

On the Tools menu, select Accounts.
In the Internet Accounts dialog box, select the name of the mail account that you just created and select Properties.
In the Properties dialog box, select the Advanced tab.

Under both the Outgoing Mail field and the Incoming Mail field, check the This Server Requires a Secure Unity
Connection (SSL) check box.

Select OK.

Caution If you do not configure Windows Mail to use SSL, the Unity Connection username (alias) and password
that are sent to Unity Connection over the network and the voice messages sent back from Unity Connection
are not encrypted.

Select Close to close the Internet Accounts dialog box.

Setting Up ViewMail for OQutlook

Cisco ViewMail for Microsoft Outlook 8.5 and Later

To install and set up Cisco ViewMail for Microsoft Outlook, see the applicable Release Notes for Cisco
ViewMail for Microsoft Outlook at http://www.cisco.com/en/US/products/ps6509/prod _release notes_list.html.

Cisco Unity Connection ViewMail for Microsoft Outlook 8.0

Using ViewMail for Outlook 8.0 to access Cisco Unity Connection voice messages, users can play and record
voice messages using the Media Master. See Figure 3-1.

Figure 1: Media Master
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Task List for Setting Up ViewMail for Outlook 8.0

ViewMail must be installed on each user workstation. Complete the following tasks to set up ViewMail 8.0
for users:
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Step 1

Step 2
Step 3
Step 4

Step 5

Configuring the IMAP Account for ViewMail for Outlook 8.0 .

Review the applicable Release Notes for Cisco Unity Connection ViewMail for Microsoft Outlook, available at
http://www.cisco.com/en/US/products/ps6509/prod_release notes_list.html. The document specifies the requirements
and procedures for installing 8.0.

If you have not already done so, install ViewMail 8.0 according to the procedures in the Release Notes for Cisco Unity
Connection ViewMail for Microsoft Outlook.

If you have not already done so, configure an IMAP account in Microsoft Outlook. See the Creating and Configuring an
Account to Access Unity Connection in Microsoft Outlook.

If users have more then one IMAP account configured, you must configure ViewMail 8.0 to use the IMAP account that
is used to access Unity Connection. See the Configuring the IMAP Account for ViewMail for Outlook 8.0.

If you use secure messaging or TRAP, you must configure several ViewMail 8.0 settings. See the Configuring ViewMail
for Outlook 8.0 Settings for Secure Messaging and TRAP.

Configuring the IMAP Account for ViewMail for Outlook 8.0

If users have more than one IMAP account configured, you must configure ViewMail 8.0 to use the IMAP
account that is used to access Unity Connection. This ensures that messages composed using ViewMail are
sent to the Unity Connection server. If users have only one IMAP account configured, ViewMail automatically
uses it to send messages to Unity Connection.

SUMMARY STEPS
1. From the Microsoft Outlook Tools menu, select ViewMail Options.
Select the Accounts tab.
3. In the Select the Account to Access Cisco Unity Connection With field, select the IMAP account that is
used to access Unity Connection.
4. Select Save.
DETAILED STEPS
Step 1 From the Microsoft Outlook Tools menu, select ViewMail Options.
Step 2 Select the Accounts tab.
Step 3 In the Select the Account to Access Cisco Unity Connection With field, select the IMAP account that is used to access
Unity Connection.
Step 4 Select Save.

Configuring ViewMail for Outlook 8.0 Settings for Secure Messaging and TRAP

Step 1

If you have configured Unity Connection for secure messaging or if you want users to be able to record or
play messages by phone using Telephone Record and Playback (TRAP), you must configure several ViewMail
8.0 settings.

After ViewMail 8.0 has been installed, do the following procedure on each user workstation.

From the Microsoft Outlook Tools menu, select ViewMail Options.
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Step 2 Select the Server tab.
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Step 3 Enter the server settings in the Table 3-1 and select Save.

Server Settings

Table 1: Server Settings

Field

Setting

Cisco Unity Connection
Server Name

Enter the name of the Unity Connection server. (Required for secure messaging
and TRAP.)

Username

Enter the Unity Connection username (alias).

Password

(Optional) Enter the Cisco PCA password (also known as the web-application
password) of the user. If you do not enter the password, the user is prompted
for it each time Microsoft Outlook is restarted. If you do not want the user to
be prompted for the password each time Microsoft Outlook is restarted, you
must also check the Remember Password check box.

Remember Password

(Optional) Check this check box if you want ViewMail to remember the user
password so that the user does not have to re-enter it each time Microsoft
Outlook is restarted.

Proxy Server Address

If you have a firewall that blocks HTTPS traffic between user workstations
and the Unity Connection server, enter the IP address of the HTTPS proxy
server.

Proxy Server Port

If you have a firewall that blocks HTTPS traffic between user workstations
and the Unity Connection server, enter the server port to use when connecting
to the HTTPS proxy server.

Validate HTTPS Certificate

If you replace the default self-signed certificate with a certificate from a
certificate authority, check the Validate HTTPS Certificate check box.

If you are using the default certificate installed with Unity Connection, this
check box must not be checked.

Extension

Enter the extension of the user.

This setting is required only if you want the user to be able to record or play
messages by phone.

Configuring Unity Connection for HTML-based Message Notification

Unity Connection can be configured to send message notifications in the form of an HTML template to an
email address. All HTML notifications in Unity Connection require an HTML-based notification template.
The HTML-based templates can be selected and applied by the administrator to allow HTML notification for
a device. The template selected can either be a default or a custom template that the administrator has created.
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Configuring the Authentication Mode .

To get the HTML notifications exactly as per the template defined by the administrator, the user’s email client
must support the display of images and icons. For more information on whether your email client support the
display of images and icons, refer to documentation of your email service provider.

HTML notifications are supported with the following email clients:
* Microsoft Outlook 2007
* Microsoft Outlook 2010
* IBM Lotus Notes

* Gmail (Web based access only)

The user must ensure to select the authentication or non-authentication mode as desired. In addition, make
sure the signed SSL certificates are installed in order to access the notifications via email and the voice message
via Mini Web Inbox.

Configuring the Authentication Mode

If the administrator has created a template that include images, icons, and/or status items, then the authentication
mode ensures that the user authenticates with his or her Unity Connection credentials before the images are
displayed as an HTML email on an email client.

By default, the system is configured for the authentication mode. The administrator can configure the
authentication mode using the Cisco Unity Connection Administration.

Step 1 In Cisco Unity Connection Administration, select System Settings > General Configuration.

Step 2 On the Edit General Configuration page, select the Authenticate Graphics for HTML Notification option to turn on the
authentication mode.

Step 3 Click Save.

\}

Note The Unity Connection credentials are required only once for each session of Microsoft Outlook.

* If the user clicks on the Cancel button and does not enter Unity Connection credentials when prompted
at the first instance then no image will be displayed in the email notification. You must restart the
Microsoft Outlook to enter the Unity Connection credentials and view the images.

« If the user enters wrong password thrice then Unity Connection will not prompt again and the user must
restart the Microsoft Outlook.

Configuring the Non-Authentication Mode

The non-authentication mode does not prompt user for credentials and the embedded images or icons are
displayed without authentication in the email notification.

Step 1 In Cisco Unity Connection Administration, select System Settings > General Configuration.
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. Configuring Microsoft Outlook to Display Images in an HTML Message Notification

Step 2 On the Edit General Configuration page, deselect the Authenticate Graphics for HTML Notification option to turn off
the authentication mode.

Step 3 Click Save.

Configuring Microsoft Outlook to Display Images in an HTML Message Notification

In the authentication mode, to view all the custom graphics or administrative replaceable images as per the
HTML-based template, you must make sure that your Microsoft Outlook client has all the required hotfixes
and registry entries.

If the non-authentication mode is configured then your Microsoft Outlook client does not require any hotfixes
or registry entries.

A

Caution  The user workstation must have the SSL certificates installed irrespective of the mode selected (authentication
or non-authentication).

If you are using Microsoft Internet Explorer version 8, refer to the settings given in the Configuring Windows
Vista and Windows 7 (32 bit and 64 bit) for Mini Web Inbox, on page 27 section.

)

Note If due to certain security implications you are not allowed to install the required hotfixes or update registry
entries, then you can create the templates without images, MWI status, and message status.
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Creating Registry Entries for Microsoft Outlook

Step 1
Step 2

Step 3

Step 4

Creating Registry Entries for Microsoft Outlook .

Table 2: Microsoft Outlook Settings Required for Authentication Mode

Microsoft Outlook

Microsoft Outlook 2007

Microsoft Outlook 2010 (32 bit and

http://support.microsoft.com/kb/953195.
Then, install Microsoft Outlook 2007
hotfix package. To install hotfix, refer to
http://support.microsoft.com/kb/2596993.
OR

* Install 2007 Office suite SP3. To install
2007 Office suite SP3, refer to
http://support.microsoft.com/kb/2526086.

e Microsoft Outlook 2007 with SP2

* Install Microsoft Outlook 2007 hotfix
package. To install hotfix, refer to
http://support.microsoft.com/kb/2596993.

* Registry entry for AllowImageProxyAuth,
where value=1.
* Microsoft Outlook 2007 with SP3

* Registry entry for AllowImageProxyAuth,
where value=1.

Version 64 bit)
Windows XP SP3, * Microsoft Outlook 2007 « Install Microsoft Outlook
Windows 7 (32 and . . 2010 hotfix package. For
64 bit), and i;ii?;?ﬁézlfor AllowlmageProxy Auth, more information, refer to
Windows Vista (32 ’ http/supportmicrosofiocomkbh 2459116,
and 64 bit) * Either Install 2007 Office suite SP2. To + Registry entry for

install 2007 Office suite SP2, refer to AllowImageProxyAuth,

where value=1.

Go to Start > Run. Type regedit and press Enter.
Browse to the following path for Microsoft Outlook 2007:

HKEY CURRENT USER\Software\Microsoft\Office\12.0\Common

Browse to the following path for Microsoft Outlook 2010:
HKEY CURRENT USER\Software\Microsoft\Office\14.0\Common

Add “AllowImageProxyAuth = 1” as new DWORD value.
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. Configuring Microsoft Outlook for Automatic Image Download

Configuring Microsoft Qutlook for Automatic Image Download

Even after updating your Microsoft Outlook with required hotfixes and registry entries, you need to right click
on the image, if any given in the template, and select Show images. You can also right click on the prompt
appearing at the above of message window to show the images.

To automatically download images without performing these steps with every session, you must select the
required options given under the Tools > Trust Center > Automatic Download section in your Microsoft
Outlook email client.

Configuring Unity Connection to Send Voice Message as an Attachment

Step 1
Step 2

Step 3

The administrator can configure Unity Connection to send the voice message as an attachment in the HTML
notification to the user. Along with the link to access Mini Web Inbox through the HTML notification email,
the user can now access the voice message attachment in the .wav format that can be played on PC or mobile
using any player. Prior to Unity Connection 10.0(1) version, the end user received only a link in the HTML
notifications to access Mini Web Inbox and listen to voice messages through Mini Web Inbox only.

\)

Note In case of forwarded messages, the attachment is sent only for the latest voice message.

If a user tries to access the voice message attachment using mobile, the following mobile clients are supported:
* Supported versions of iPhone 4 and above

* Supported versions of Android

N

Note The secure and private voice messages cannot be sent as an attachment.

By default, the system is configured for not to send the voice message as an attachment. The administrator
can configure to send voice message as an attachment using the Cisco Unity Connection Administration.

In Cisco Unity Connection Administration, select Advanced > Messaging.

On the Messaging Configuration page, select the Allow voice mail as attachments to HTML notifications option to send
the voice message as an attachment.

Click Save.

Configuring the Size of Voice Messages Sent as an Attachment with HTML Notification

The administrator can configure the size of voice messages sent as an attachment with HTML notifications.
The user can access the voice message attachment in the .wav format that can be played on PC or mobile
using any player.

By default, the system is configured to send the voice message as an attachment upto 2048KB and maximum
size can be 12288 KB. The administrator can configure the size of the voice message using the Cisco Unity
Connection Administration.
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Step 1
Step 2

Step 3

Configuring Unity Connection for Mini Web Inbox .

In Cisco Unity Connection Administration, select Advanced > Messaging.

On the Messaging Configuration page, enter the size of voice message in the Max size of voice mail as attachment to
HTML notifications (KB) text box.

Click Save. Make sure to restart the Connection Notifier service in order to changes take effect.

Configuring Unity Connection for Mini Web Inbox

Configuring IBM Lotus Notes for Mini Web Inbox

Step 1
Step 2
Step 3

Mini Web Inbox does not support the default IBM Lotus Notes supported browser. When a user receives a
message notification on his IBM Lotus Notes email client and clicks a link in the notification to open Mini Web
Inbox, the Mini Web Inbox must open in the default operating system browser.

In your Lotus Notes client, select File > Preferences > Web Browser.
Select the Use the browser I have set as the default for this operating system option.
Click Apply and then Ok.

Configuring Windows Vista and Windows 7 (32 bit and 64 bit) for Mini Web Inbox

Step 1
Step 2
Step 3
Step 4

Step 5
Step 6
Step 7

Select Start > Control Panel > Flash Player.
Select the Camera and Mic tab in the Flash Player Settings Manager window.
Click Camera and Microphone Settings by Site.

Select the Ask me when a site wants to use the camera or microphone option in the Camera and Microphone Settings by
Site window.

Click Add.
Add the website that you are using for Unity Connection, for example, ucbu-cisco-vmxyz.cisco.com.
Click Allow and then Close.

Troubleshooting IMAP Client Sign-In Problems

When users change their Cisco PCA password (also known as the web-application password) in the Messaging
Assistant, they also must update the password in their IMAP client application so that the client can continue
to access Unity Connection and retrieve voice messages.

If users have trouble receiving voice messages in an IMAP client, consider the following possibilities:

* If the IMAP client application prompts a user for the Cisco PCA password, but does not accept it, the
Cisco PCA password may have expired or changed, or is locked. Users can change their password in the
Messaging Assistant first and then update it from their IMAP client application.
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* If Microsoft Outlook users are not prompted for their Cisco PCA password, verify that the Remember
Password check box on the Internet E-mail Settings (IMAP) page is not checked. If this option is checked,
and the password of the user has expired, changed, or is locked, Microsoft Outlook does not prompt the
user to enter the Cisco PCA password. The result is that the user does not receive voice messages from
Unity Connection, and Microsoft Outlook prompts for the username and password.
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* User Orientation, on page 29

User Orientation

Orientation Task List for Unity Connection Users

After you set up the client applications that users will use to access Cisco Unity Connection from their phones
and computers, use the following task list to acquaint users with Unity Connection. If you are planning
supplemental Unity Connection training, also consider reviewing the potential user concerns and misconceptions
listed in the Support Desk Orientation, on page 40section.

Offer User Documentation and Contact Information

1.

Give users a Cisco Unity Phone Menus and Shortcuts wallet card. Use the Wallet Card wizard to produce
the card. The templates in the wizard list frequently used menu options and shortcuts for managing
Unity Connection messages and user preferences by phone; the wizard fills in the applicable keys based
on the conversation that you specify. The resulting PDF is formatted as a wallet card that can be printed,
then cut out and folded by users.

Procedures in the User Guide for the Cisco Unity Connection Phone Interface do not contain the keys
that users press for Unity Connection menu options. Instead, the procedures use the prompts that users
hear to specify the menu options to choose. To provide users with key information, you must use the
Wallet Card wizard.

The Wallet Card wizard also allows you to customize technical support information and instructions
for signing in to Unity Connection. The Wallet Card wizard is a Windows-based remote database
administration tool. Download the tool and view Help at
http://www.ciscounitytools.com/Applications/CxN/WalletCardWizard/WalletCard Wizard.html.

Give each user applicable user guides. The following Cisco Unity Connection user guides are available
at http://www.cisco.com/en/US/products/ps6509/products_user guide list.html.

* User Guide for the Cisco Unity Connection Phone Interface
* User Guide for the Cisco Unity Connection Messaging Assistant Web Tool

* User Guide for the Cisco Unity Connection Messaging Inbox Web Tool
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10.

11.

12.

* User Guide for Accessing Cisco Unity Connection Voice Messages in an Email Application
* User Guide for the Cisco Unity Connection Personal Call Transfer Rules Web Tool

* Quick Sart Guide: Using the Cisco Unity Connection Web Inbox

* Quick Sart Guide: Using Cisco ViewMail for Microsoft Outlook

Information in the guides is generally organized by feature. You can distribute the guides for the interfaces
that users are using, or you can distribute feature-specific information to users for whom you have
enabled the features. (On Cisco.com, select the link for the topics you want, and print the PDF files.)

Give users the phone numbers that they dial to access Unity Connection from within your organization
and from outside the organization. As applicable, show users which button or key to use on their desk
phones to access Unity Connection.

Give users the URL to the Cisco PCA website: http://<Unity Connection server name>/ciscopca.

Give users the URL to the Cisco Unity Connection Web Inbox: http://<Unity Connection server
name>/inbox.

Give users the name, extension, and/or email address of the Unity Connection administrator and any
support desk contact information.

Depending on the conversation version that users in your organization are familiar with, you may want
to provide them with a list of phone menu differences between Unity Connection and a former voice
messaging system—especially if you choose not to offer them an alternative to the standard conversation,
which is specified by default in the Voice Mail User template.

Provide PINs, Passwords, and Security Guidelines

Provide users with their initial phone PINs. Alternatively, tell users to sign in to the Cisco Personal
Communications Assistant (PCA) website to set their phone PINs before they call Unity Connection to
complete first-time enrollment. (Users are not required to enter an existing phone PIN in order to change
it in the Cisco PCA.)

If users choose not to initially change their PIN in the Cisco PCA, they are prompted to change their
phone PIN during first-time enrollment.

Provide users with their initial Cisco PCA passwords. Users must use the Unity Connection Messaging
Assistant to change their Cisco PCA passwords.

Explain to users how to secure their phone and Cisco PCA PINs and passwords so that they adequately
protect their Unity Connection mailboxes from unauthorized access. Detail the security guidelines for
your organization. Encourage users to enter secure PINs and passwords whenever they change them.

Make sure users understand that their Cisco PCA passwords are not related to their Unity Connection
phone PINs, nor are the passwords and PINs synchronized. Users may assume that their phone and
Cisco PCA PIN and password are the same. As a result, they may think that they are changing both
when the Unity Connection conversation prompts them to change their phone PIN during first-time
enrollment. For this reason, you may find that many users do not consider securing their Cisco PCA
passwords, even though you request that they do so.

Remind Users to Complete First-Time Enrollment

Make sure that users know that they need to complete first-time enrollment by phone. They do not need
to refer to any Unity Connection documentation during enrollment. Unity Connection indicates when
the enrollment process is complete. If users hang up before they have completely enrolled, none of their
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13.

14.

15.

16.
17.

18.

19.

20.

Offer User Documentation and Contact Information .

changes are saved and the first-time enrollment conversation plays again the next time that they sign in
to Unity Connection.

The “Enrolling as a Cisco Unity Connection User” chapter of the User Guide for the Cisco Unity
Connection Phone Interface (Release 15), available at https://www.cisco.com/c/en/us/td/docs/voice
ip_comm/connection/15/user/guide/phone/b 15cucugphone.html. details the tasks that users are asked
to complete as part of enrollment.

Explain How Unity Connection Features and Functionality Work

Provide training on how to personalize user settings using the phone and the Unity Connection Messaging
Assistant, as summarized in Table 3: Settings Users Change Using the Messaging Assistant and Phone
Menus. In particular, users may benefit from a hands-on demonstration of the Messaging Assistant, as
they may not be accustomed to using a web interface to set voice messaging options.

Provide training on how to use the Cisco Unity Connection Personal Call Transfer Rules web tool, and
how call transfers, call holding and screening, and caller options are used, as summarized in Table 4:
Settings Users Change Using the Cisco Unity Connection Personal Call Transfer Rules Web Tool and
Phone Menus.

See the User Guide for the Cisco Unity Connection Personal Call Transfer Rules Web Tool (Release
15) or to Cisco Unity Connection Personal Call Transfer Rules Help for further guidance after orientation.

Explain how full mailboxes work with Unity Connection. See the Support Desk Orientation for issues
that users may encounter. Refer users to the appropriate user guides for similar information.

If single inbox is configured: Discuss single-inbox behavior with users

If your organization has users who will use RSS readers to access voice messages, provide training on
using RSS with Unity Connection.

If your organization has users who will use TTY and the TTY prompt set, provide training on using
TTY with Unity Connection.

Make sure that users who own call handlers or system distribution lists understand their responsibilities
(if applicable).

As applicable, tell users how to use the Cisco Unity Greetings Administrator and System Broadcast
Administrator.
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Settings that Unity Connection Users can Change

Settings Users Change Using Messaging Assistant and Phone Menu

Table 3: Settings Users Change Using the Messaging Assistant and Phone Menus

Settings Changed Using the Messaging Assistant Settings Changed Using the Phone Menus
Call Holding and Screening(1) : Call Holding and Screening]:
* Select how Unity Connection handles indirect calls when * None

the user phone is busy, including placing the caller on
hold, prompting the caller to hold or leave a message,
and sending the caller directly to the greeting

* Select how Unity Connection handles indirect calls,
including telling the user who the call is for, announcing
that Unity Connection is transferring the call, prompting
the user to accept or refuse a call, and prompting callers
to say their names

Call Transfers(2) : Call Transfers2:
* Configure the three basic transfer rules: standard, * Configure the three basic transfer rules: standard, alte
alternate, and closed hours closed hours

* Enable or disable personal call transfer rules for each of * Enable or disable personal call transfer rules for each o

the basic transfer rules transfer rules

« Transfer indirect calls to an extension or send them to « Transfer indirect calls to an extension or send them t
the user greeting greeting

* Change extensions * Change extensions

* Configure alternate contact numbers for caller input |
are assigned to the Transfer to Alternate Contact Num

Caller Options: Caller Options:

* Allow callers to edit messages * None

* Allow callers to mark messages urgent
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Settings Changed Using the Messaging Assistant Settings Changed Using the Phone Menus

* Set language for Unity Connection prompts

* Specify whether users use the phone keypad or
voice-recognition input style

* Set speed and volume of prompts, recorded names, and
user greetings

* Select full or brief Unity Connection conversation menus

* Select the action that Unity Connection performs when
the user calls Unity Connection, including greeting the
user by name, and announcing the number of new
messages by type

* Change the time format used for message time stamps

* Specify alternate extensions

Phone Menu Options: Phone Menu Options:

* Select full or brief Unity Connection conversatio:

Greetings:

* Record a personal greeting
* Enable or disable greeting
* Specify an expiration date for an enabled greeting

* Switch between system prompt and personal greeting

Greetings:
* Record a personal greeting
* Enable or disable greeting

* Specify an expiration date for an enabled greeting

Message Notification:
* Enable or disable a notification device
* Specify dialing or recipient options

* Select the types of messages and message urgency for
which Unity Connection generates a notification

* Specify a list of message senders (by username or calling
phone number) for which Unity Connection generates a
notification

* Set up a notification schedule, and specify what happens
when a device does not answer, is busy, or fails

Message Notification:

* Enable or disable a notification device, and chang
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Settings Changed Using the Messaging Assistant

Settings Changed Using the Phone Menus

Message Playback:

* Specify the speed and volume of messages that are played
by phone

* Specify message playback order

* Specify whether Unity Connection plays the Message
Type menu

* Select the action that Unity Connection performs when
messages are played, including announcing the name
and number of the sender who left a message, and
whether the time stamp is played before or after the
message

* Specify that messages are marked saved upon hang-up
or disconnect

* Specify whether Unity Connection asks to confirm
deletions of new and saved messages

Message Playback:

* Speed and volume of message as it is played

Message Sending and Addressing:

* Specify that Unity Connection prompts to confirm
message recipients by name

* Specify that Unity Connection prompts to continue
adding names after each recipient

* Specify that Unity Connection sends messages when
users hang up or a call is disconnected

 Switch between addressing messages to other users by
name, or by extension

* Specify order for addressing messages by name (last
name then first name, or vice versa)

Message Addressing:

* Switch between addressing to other users by name or
extension (by pressing ##)(3)

* Review, add, or remove names in the addressing prio

Personal Settings:

* Record a name

* Specify alternate names

* Change directory listing status
* Change password or PIN

* Add user-defined alternate extensions(5)

Personal Settings:

* Record a name

* Change directory listing status

* Change password or PIN

* Add user-defined alternate extensions5

« Edit alternate contact numbers, if an administrator has ¢
one or more caller input keys to transfer to an alterna
number during the user greeting
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Settings Changed Using the Messaging Assistant Settings Changed Using the Phone Menus
Private Lists: Private Lists:

* Enter a display name * Record a list name

* Record a list name * Add and delete members

¢ Add and delete members

Contacts: Contacts:
* Set up contacts to use for both name dialing and call * None
transfer rules
12345

(1) Call holding and screening options apply only to incoming calls that were routed to the user from
the automated attendant or a directory handler, and not on direct calls. Holding and screening options
do not apply when an outside caller or another user dials a user extension directly. In addition, holding
and screening options are only available when supervised transfers are enabled. These settings apply if
the user does not have personal call transfer rules enabled.

(2) Call transfer options apply only to incoming calls that were routed to the user from the automated
attendant or a directory handler, and not on direct calls. Transfer options do not apply when an outside
caller or another user dials a user extension directly.

(3) Note that this depends on whether you have enabled spelled name addressing.

(4) To enable users to access the setup conversation that allows them to review, add, or remove names
in the addressing priority list, the users must be assigned to a custom conversation, and you must use
the Custom Keypad Mapping tool to map the Addressing Priority List conversation to a key in the
Message Settings menu for that conversation.

(5) Users must belong to a class of service with the Allow Users to Manage Their User-Defined Alternate
Extensions option enabled. To enable users to access the phone menu conversation that allows them to
review, add, or remove alternate extensions, the users must be assigned to a custom conversation, and
you must use the Custom Keypad Mapping tool to map the Edit User-Defined Alternate Extensions
option to a key in the Preferences Menu for that conversation.
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Settings Users Change Using Cisco Unity Connection Personal Call Transfer Rules and Phone
Menu

Table 4: Settings Users Change Using the Cisco Unity Connection Personal Call Transfer Rules Web Tool and Phone Menus

Settings Changed Using the Personal Call Transfer Rules Web | Settings Changed Using the Phone Menus
Tool

Call Holding and Screening: Call Holding and Screening:

* Set up personal call transfer rules to specify how Unity * None
Connection handles direct and indirect calls when the
user phone is busy, including placing the caller on hold,
prompting the caller to hold or leave a message, and
sending the caller directly to the greeting

* Set up personal call transfer rules to specify how Unity
Connection handles direct and indirect calls, including
telling the user who the call is for, announcing that Unity
Connection is transferring the call, prompting the user
to accept or refuse a call, and prompting callers to say
their names

Call Transfers: Call Transfers:
* Set up personal call transfer rules to transfer direct and * Enable or disable personal call transfer rules to transt
indirect calls to an extension, to an external phone or indirect calls to an extension, to an external phone
number, or to the greeting or to the greeting

« Enable or disable the Transfer All rule set to forward
voicemail or to another phone number

* Forward all incoming calls directly to Unity Connect
than to phone extension

Caller Options: Caller Options:

+ Allow callers to edit messages * None

* Allow callers to mark messages urgent

Destinations: Destinations:

* Set up phone numbers or notification devices to use when * None
transferring calls

* Set up groups of destinations to use in personal call
transfer rules

* Specify the number of rings that Unity Connection waits
before transferring the call to the next destination or to
voicemail
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Settings Changed Using the Personal Call Transfer Rules Web | Settings Changed Using the Phone Menus
Tool

Caller Groups Caller Groups

* Create groups of user-defined contacts, * None
administrator-defined contacts, or Unity Connection users
to use in personal call transfer rules
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Operator and Support Desk Orientation

* Operator and Support Desk Orientation, on page 39

Operator and Support Desk Orientation

Overview

Operators in your organization need information about Cisco Unity Connection that is specific to your
installation. In addition, if your organization has a support desk, the staff need to be prepared to answer the
questions that users may ask, and to be aware of the resources that are available to assist them in answering
user questions.

Operator Orientation

Operator orientation should address the same points as user orientation, but in greater detail. Operators must
be familiar with how users use Unity Connection. Depending on the size of your organization, the operator
may be the person users are likely to ask when they have questions about Unity Connection.

In addition to the information in the User Orientation chapter and the Support Desk Orientation (as applicable),
operators also need to understand the following concepts and tasks.

Roles of the Operator and the Automated Attendant

The way your organization uses the automated attendant determines what the operator responsibilities are.
The automated attendant is a call handler that is used in place of a human operator to answer and direct calls
by playing greetings and responding to caller input. The automated attendant can provide a menu of options
(for example, “For Sales, press 1; for Service, press 2.”), and it can also provide information (for example,
“Our normal business hours are Monday through Friday, 8 a.m. to 5 p.m.”).

Directing Calls

Regardless of how your organization uses the automated attendant, many calls go to the operator. The operator
must know how to direct calls to voicemail and to user phones. With Cisco Unified Communications Manager,
you can program the phone to direct calls to voicemail. For details on setting this up, see the tech note How
to Transfer a Caller Directly into a Cisco Unity Mailbox, available at
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_tech notes list.html.

Forwarding Messages to Intended Recipients
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If an operator also owns a call handler or system distribution list, make sure that the operator knows to review
messages frequently, and to forward messages as necessary to the applicable recipients.

Using the Cisco Unity Greetings Administrator

An operator who is responsible for changing call handler greetings for the organization can use the Cisco Unity
Greetings Administrator when it is not practical to change a greeting in Cisco Unity Connection Administration.
For example, if the office is unexpectedly closed because of bad weather, the operator can call from home to
use the Cisco Unity Greetings Administrator to enable the alternate Opening Greeting, or to rerecord a call
handler greeting stating that the office is closed.

Using the Cisco Unity Broadcast Message Administrator

If an operator is responsible for sending recorded announcements to everyone in an organization (or to particular
locations within an organization), explain how to access and use the Cisco Unity Broadcast Message
Administrator to send broadcast messages.

Support Desk Orientation

Support desk orientation should address the same points as user and operator orientation, but in greater detail.
Support desk staff must be familiar with how users and operators use Unity Connection, and the common
problems that users may encounter when using Unity Connection. Instead of using the Unity Connection
server, it may be helpful to set up a test server that support desk staff can use to browse to Cisco Unity
Connection Administration, and troubleshoot and test client applications.

To prepare for possible calls to the support desk at your organization, familiarize the support desk staff with
the resources listed in the following Support Desk Resources section, and with the potential user concerns
and misconceptions listed in the Potential User Concerns and Misconceptions. (See also theOperator Orientation
and the “User Orientation” chapter.)

Support Desk Resources

* User documentation is available at
http://www.cisco.com/en/US/products/ps6509/products_user guide_list.html.

* The Compatibility Matrix: Cisco Unity Connection and the Software on User Workstations is available
at http://www.cisco.com/en/US/products/ps6509/products_device support_tables list.html.

* The following chapters in this guide provide information on how user workstations should be set up, and
describes how users use Unity Connection client applications:

* Setting Up Access to Cisco Personal Communications Assistant
* Setting Up Playback and Recording Devices

* Configuring an Email Account to Access Unity Connection Voice Messages

* The Troubleshooting Guide for Cisco Unity Connection Release 15 is available at https://www.cisco.com/
c/en/us/td/docs/voice _ip comm/connection/15/troubleshooting/guide/b 15cuctsg.html.

* For descriptions and the URLSs of all Unity Connection documentation on Cisco.com, see the
Documentation Guide for Cisco Unity Connection Release 15. The document is shipped with Unity
Connection and is available at https://www.cisco.com/c/en/us/td/docs/voice ip _comm/connection/15/
roadmap/b_15cucdg.html.
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Potential User Concerns and Misconceptions

Table 5: Potential User Concerns and Misconceptions describes potential user issues, which are typically
based on misconceptions about how Cisco Unity Connection works. Users who encounter such issues are
often those who are accustomed to another voice messaging system, have not yet completed Unity Connection
training, or are unaware of a new feature or functionality change to an existing system.

Table 5: Potential User Concerns and Misconceptions

Potential Issue

Description

Delayed messages

Users may believe that their messages are delayed for the following reasons:

» While listening to new messages, users may skip a message and inadvertently mark :
when they check messages again, they hear the skipped message and believe that the m:
after a delay.

» Users may skip more messages than they intend while listening to their messages, ar
messages again only to hear one or more of the skipped messages, and believe that tl
arrived after a delay.

* While listening to messages, other new messages arrive that users may not be aware o
they check messages again, they hear the new messages and believe that they were d

Deleted messages

By default, when users delete a new or saved message, Unity Connection does not ask the
the deletion. You may want to enable Unity Connection to request confirmation from use
proceeding with the deletion, especially if many users do not belong to a class of service th:
to retain and review their deleted messages. You can set up Unity Connection to confirm
messages on the System Settings > Advanced > Conversations page in Cisco Unity Conn
Administration.

For information on deleted messages, see the “Managing Deleted Messages” chapter of th
for the Cisco Unity Connection Phone Interface (Release 15), available at https:/www.ci
us/td/docs/voice ip comm/connection/15/user/guide/phone/b_15cucugphone.html.
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Potential Issue

Description

Deleted messages: IMAP
and MAPI behavior

When users access messages stored on a Microsoft Exchange server both from a Microsoft Out!
and from Unity Connection, they may experience unexpected and confusing behavior when ¢
messages. The difference in behavior occurs when the Microsoft Outlook client is configured
MAPI, the Microsoft interface for connecting to Exchange, and stems from the fact that MAI
IMAP—the protocol used by Unity Connection—use different mechanisms for marking mes:
deleted.

If you have users who access a Microsoft Exchange server using Outlook (with MAPI) or Ou
Access, and who also use Unity Connection to manage messages on the same message store,
alert them to this behavior.

Deleted Messages—IMAP Behavior

When a user deletes a message from Microsoft Outlook, the message is moved from the Inbo
Deleted Items folder. At this point, Unity Connection can no longer access the message, and |
indicates that the message exists either as a new, saved, or deleted message.

Deleted Messages—MAPI Behavior

When a user deletes a message from Unity Connection, the message remains in the Inbox but
to indicate that it has been marked deleted by the user. However, when configured to use MAPI,
Outlook does not recognize this flag as a deletion, and continues to display the message as a ne
message in the Inbox.

Device for recording or
playback does not show
in ViewMail for Outlook
device lists

When users add or turn on a new recording or playback device, they must restart the ViewM:z
Outlook add-in so it can recognize the new device. To restart ViewMail, restart Outlook.

Directory listing: users
are not listed as expected

When users do not have a recorded name, they are not listed in the corporate directory and as
outside callers are not be able to find them when searching for them by name. By default, Unity C
prompts users to record a name during first-time enrollment, but it does not prevent them from c
the enrollment process if they do not.

To address this issue, consider the following options:

* You can change whether recording a name is required to complete first-time enrollment
System Settings > Advanced > Conversations page in Cisco Unity Connection Adminisf

* You can provide recorded names for users in Cisco Unity Connection Administration.

* Users with class of service rights can record their own names using the Unity Connection co
or the Unity Connection Messaging Assistant.

Note This problem does not occur for internal users, but only for outside callers;
Connection users who address messages by name are still able to find other u

if they have not recorded a name.

Fax: attached files are not
delivered to fax machines

(fax integrations only)

Users may be unaware that when they add attachments to an email message and then send the
to a fax machine, Unity Connection renders only those attachments with the file extensions s;
during Unity Connection setup. All other attachments are removed.
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Potential Issue

Description

IMAP client: Differences
in client behavior

Users who use different third-party IMAP clients to access voice messages from their desl
may note the following discrepancies in behavior:

* Microsoft Outlook client:

* For new messages, the “Mark as Unread” feature marks messages as new on the
Connection server, regardless of whether the WAV file message attachment is d
not.

* Voice messages that are deleted by phone are marked for deletion in the Outloo)
are changed to strikethrough text when users select the “Send/Receive” comma

* Novell GroupWise client:

* When new messages with the WAV file message attachment have been downlo:
GroupWise client, the “Read Later” feature no longer marks the message as new
Connection server.

* Voice messages that are deleted by phone are not marked for deletion in Group?
need to manually delete them from this client.

» GroupWise users need to use the “Send/Retrieve” command to update message
the Unity Connection server.

Mailbox fills up quickly

Users may complain that their mailboxes are filling up too quickly, for any of the followi

* Unity Connection does not automatically delete messages when they reach a certain ag
that user messages are saved until the user deletes them permanently. (For informatic
permanently delete messages, see the “Managing the Size of Your Mailbox” chapter
Guide for the Cisco Unity Connection Phone Interface (Release 15), available at
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/15/user/guide/ph
15cucugphone.html).

* When users receive nondelivery receipts (NDRs) to messages that they send, their er
mailbox can quickly increase in size—especially if the original message included larg
For users who have access to email messages via TTS, if their email clients are conf
their sent messages, the original message and attachments are stored in their Sent Iten
another copy is sent to their Inboxes along with the NDR, increasing their mailbox siz

» Users may receive messages that have been forwarded many times over, which incre
size. The original message plus all recorded introductions that were added during for
the total message size. As a result, users who have relatively few messages stored in th
may still find that their mailboxes exceed the storage limits.

» User mailboxes can fill up while users are on vacation or on an extended leave of ab
prevent this, specify that Unity Connection prevents callers from leaving messages wt
their alternate greetings enabled.

Message notification:
repeat notification options

When a user chooses not to have Unity Connection restart notification each time a new me
setting a long interval between repeat notification calls may lead the user to believe that Uni
is delaying notification.
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Potential Issue

Description

Media Master: opening a
file that is saved on a
workstation

When a user attempts to use a previously recorded WAV file (for example, an announcement
recorded earlier) rather than recording using a phone or a computer microphone, the Media M
display an error message. The error occurs when the WAV file was recorded in the G.729a aud
To resolve the problem, the user must do one of the following:

» Convert the WAV file to another audio format (for example, convert it to the G.711 audi
» Use a WAV file that is recorded in a supported audio format other than G.729a.

* Make the recording using a phone or a computer microphone.

MWIs

To gain an understanding of when MWIs turn on and off, what causes them to turn on and off
causes MWIs to behave differently than expected, see the “Troubleshooting Message Waiting
(MWIs)” chapter of the Troubleshooting Guide for Cisco Unity Connection, Release 15, at
https://www.cisco.com/c/en/us/td/docs/voice ip_comm/connection/15/troubleshooting/guide
15cuctsg.html.

Passwords and PINs are
not secure, Or users use
the wrong password or
PIN

Users may assume that their phone PINs and Cisco Personal Communications Assistant (PCA)
are the same or are synchronized. As a result, they may think that they are changing both PIN anc
when Unity Connection prompts them to change their phone PIN during first-time enrollment. Ac
they may try to use their phone PIN to sign in to the Cisco PCA.

Speed for elements of the
Unity Connection
conversation varies

Users may report that the speed at which Unity Connection plays menus, recorded names, grec
messages is inconsistent. For example, users may report that when they listen to their messag
message is played at a different speed than the recorded names of users who leave them mess
the message properties (for example, the time stamp and message number).

Such inconsistencies are expected when you consider the following:

* Unity Connection plays recorded names and greetings at the speed at which they were re
Neither you nor users can affect the playback speed of recorded names and greetings.

» Messages played via Text to Speech (TTS) are always played at normal speed by default,
of message playback settings.

* The speed that you or a user specifies for system prompts—the standard recordings that
the Unity Connection system, including prompts for message properties—does not affect th
speed of messages.

* The speed that users specify for message playback does not affect system prompts.

Unread messages

Depending on how Unity Connection is set up at your organization, users may be surprised at |
Connection handles messages when calls are intentionally or unintentionally disconnected (for
when a user hangs up or when a mobile phone loses its charge or signal) while users are in th
of listening to new messages. Some users may incorrectly assume that Unity Connection mar
message as read, which is not the case.

You can change how Unity Connection handles unread messages when calls are disconnected by
the Mark Message Saved If User Hangs Up setting on the System Settings > Advanced > Con
page of Cisco Unity Connection Administration.
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Potential Issue

Description

Unsent messages

Depending on how Unity Connection is set up at your organization, users may be surprised
Connection handles messages when calls are intentionally or unintentionally disconnected
when a user hangs up or when a mobile phone loses its charge or signal) while users are i
of sending, replying to, or forwarding a message. Some users may incorrectly assume tha
Connection offers a draft folder for unsent messages, which is not the case.

You can change how Unity Connection handles unsent messages when calls are disconnecte
the Send Message If User Hangs Up During Recording setting on the System Settings > /
Conversations page of Cisco Unity Connection Administration.
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